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Abstract 

Accessibility awareness is spreading due to high profile statutes and guidelines such as Section 
508 of the Rehabilitation Act and the WCAG 2.0 guidelines. Unfortunately, the audience for 
accessibility is limited to web developers and IT staff. Students and faculty are increasingly 
interacting with digital resources such as course readings and web portals, and are taking on the 
role of content creator as well as consumer. Students and faculty make decisions every day, 
conscious or not, which affect the accessibility of their files, but most available resources are 
targeted at web developers with high-level technical knowledge. This project evaluates the 
current literature pertaining to accessibility in education, and compares selected international 
institutions in case studies based on guidelines and resources offered to faculty, staff, and 
students. A set of best practices are offered that specifically addresses this audience. These best 
practices have been created such that an instructor with limited time and technical knowledge 
can realistically read and follow the recommendations. The guide also explains the need for 
accessibility and the benefits that properly formatted documents offer to all users. Because 
classrooms today are a blended environment of physical and virtual spaces, accessibility is no 
longer the exclusive responsibility of web developers and IT staff. The resources and literature of 
accessibility must be adapted to reflect the evolving digital environment of education, and this 
project is a first step in that process. 
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Introduction 

 Accessibility is mandated by laws such as Section 508 of the United States Rehabilitation 

Act, and supported by guidelines such as the Web Content Accessibility Guidelines.  Even so, 

accessibility remains the domain of web developers, to the frustration of people with disabilities. 

The tools of electronic content creation are becoming more widely adopted and easier to use 

such that one does not need to be an expert to become a content creator.  In the classroom, 

electronic resources are often commonplace. Readings are accessed through a learning 

management system. Assignments are emailed back and forth. Students collaborate on notes and 

projects. Accessibility in education is now in the hands of students, faculty, and staff. Web 

developers are now a minority among those authoring digital documents, but the landscape of 

accessibility has not been adapted to reflect this changing climate.  

Review of Literature 

Web Accessibility 

 Published by the World Wide Web Consortium (W3C), the Web Content Accessibility 

Guidelines (WCAG) is an established and acknowledged cornerstone of web accessibility 

literature.  The first version, WCAG 1.0, was published in 1999, and has since been updated to 

version 2.0. The document organizes guidelines under four principles of accessibility; content 

should be “perceivable, operable, understandable, and robust” (The World Wide Web 

Consortium (W3C), 2008). Each guideline is then ranked according to conformance levels A, 

AA, and AAA. Level A guidelines have the greatest influence on accessibility and represent a 

minimum standard. Level AAA guidelines are more difficult to achieve and begin to affect a 

smaller audience (W3C, 2008). 
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 An example of a Level A guideline is 1.1.1 which requires that “All non-text content that 

is presented to the user has a text alternative that serves the equivalent purpose, except for the 

situations listed below…”(W3C, 2008).  Meeting this guideline for a web site involves alt text, a 

description of the image’s content and purpose that can be read by assistive technologies such as 

screen readers.  The following Level AAA guideline, 1.2.6, characterizes the difference between 

A and AAA requirements: “Sign language interpretation is provided for all prerecorded audio 

content in synchronized media” (W3C, 2008). Level A priorities are broad, and can be met in 

almost all circumstances. It might be impossible, on the other hand, for an organization to 

provide sign language interpretation for all videos in addition to the Level AA requirement to 

provide “Audio description … for all prerecorded video content in synchronized media…” (W3C, 

2008, 1.2.5).  

 While many acknowledge the contribution of the W3C and WCAG 2.0  to removing 

barriers to people with disabilities, Kelly, Sloan, Phipps, Petrie, and Hamilton (2005) argue that 

“in the context of evaluation and policymaking, inappropriate reference to the WCAG may lead 

to serious practical difficulties in implementation and monitoring of an effective accessibility 

policy” (p. 2). The WCAG guidelines alone are not sufficient to certify a website as accessible. 

The guidelines, and many of the automated tests that apply them, are at least useful in 

establishing an “upper bound” of accessibility (Kelly, et al., 2005, p. 2). Checking off every 

Level A guideline will ensure that all images include alt text or a text equivalent, but WCAG is 

not enough to evaluate the quality of alt text provided. This limitation is amplified in the case of 

automated evaluation tools such as WAVE (WebAIM, 2012a).  

The Future of Accessibility 
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 In response to the aforementioned limitations of WCAG 2.0, Kelly et al. (2007) argue for 

a more holistic approach to accessibility, “a user-focused approach” that reflects “the context of 

usage, including the aims of a service (informational, educational, cultural, etc.), the users’ and 

the services providers’ environment” (p. 1). According to the authors, WCAG is limited by its 

focus on individual technologies. In envisioning WCAG as a final destination for web 

accessibility, a universal set of standards, the W3C Web Accessibility Initiative (WAI) 

responsible for creating and maintaining the WCAG has compromised the overall effectiveness 

of WCAG.  

 In “Accessibility 2.0: People, Policies and Processes,” Kelly et al. (2007) call for a 

reevaluation of best practices in accessibility that take into consideration “how to meet the needs  

of disabled people, within local contexts that users and their support workers are operating” that 

can be taken from existing pools of accessibility knowledge (p. 4). In this manner, content 

creators of all types can know how to apply existing and evolving practices in accessibility to 

their own contexts and abilities.  

 WCAG stands for Web Content Accessibility Guidelines, and their content and execution 

reflects a focus on accessibility on the web. The authors of WCAG 2.0 did not focus solely on 

HTML, but expanded to include other content such as multimedia that may appear on a web 

page (Kelly, et al., 2007, p. 2). Unfortunately, WCAG is still very much targeted at web 

developers, and the language of the guidelines reflects this focus:  

In content implemented using markup languages, elements have complete start and end 

tags, elements are nested according to their specifications, elements do not contain 

duplicate attributes, and any IDs are unique, except where the specifications allow these 

features. (W3C, 2008, 4.1.1) 
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As a result, accessibility is often left to web developers or the IT department.  

As technology begins to permeate our lives in more ways, interacting with electronic 

documents has become a part of the everyday experience. Web developers are not the only ones 

taking on the role of content creator. PDF files and Word Documents often move directly from 

author to Internet. As helpful as WCAG has been, it has done little to encourage anyone outside 

of web developer circles to take responsibility for their content.   

Accessibility in Education 

Research 

  In “International Research on Web Accessibility for Persons with Disabilities,” 

Thompson, Burgstahler, Moore, Gunderson, and Hoyt (2007) establish “a global benchmark for 

web accessibility by evaluating 8557 higher education home pages and 6872 national 

government web pages for 181 United Nations member states.” In addition to their exhaustive 

evaluations, the authors consider underlying factors that affect accessibility across countries. 

Thompson et al. (2007) found that web pages tend to be more accessible in countries with higher 

rates of computer ownership, more exposure of disability-related issues in the media, and 

commerce that requires international communication, such as tourism. They also found 

significant correlations between Hofstede’s (2001) cultural dimensions of Power Distance and 

Individualism vs. Collectivism. Countries with a lower Power Distance Index, meaning a 

stronger belief in equal rights across society, had more accessible web sites. High Individualism 

also correlated with more accessibility.  

  “International Research on Web Accessibility for Persons with Disabilities” (Thompson, 

et al., 2007) is significant in that it pairs the common approach of broad accessibility evaluations 

(e.g. Petrie, King, & Hamilton, 2005; Hackett & Parmanto, 2005) with an analysis of the 
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possible contributing variables. While this research is a valuable addition to accessibility 

literature, it contributes to the developer-centered focus on accessibility; Thompson et al. (2007) 

do not consider pressures and motivations for increased accessibility within institutions. 

 Web Accessibility in Mind (WebAIM) is a non-profit organization affiliated with the 

Center for Persons with Disabilities at Utah State University. WebAIM offers resources in web 

accessibility, “… to expand the potential of the web for people with disabilities by providing the 

knowledge, technical skills, tools, organizational leadership strategies, and vision that empower 

organizations to make their own content accessible to people with disabilities” (WebAIM, 

2012b). WebAIM also conducts accessibility-related research.  

In “University Web Accessibility Policies: A Bridge Not Quite Far Enough,” WebAIM 

researchers examined the accessibility policies of 20 universities located in the United States 

(n.d.). They found that policies were overall deficient. Most:  

… fail to delineate a specific technical standard, fail to indicate whether compliance with 

the policy is required, fail to indicate a timeline or deadline for compliance, fail to define 

a system for evaluating or monitoring compliance, and fail to enumerate any 

consequences for failure to comply. (WebAIM, n.d.) 

Web accessibility is a concern at each institution, but few accessibility policies support their 

supposed commitment. Researchers also found basic accessibility errors in university web sites. 

If web masters and developers officially responsible for accessibility struggle to write and follow 

their own policies, then it should not be surprising that there is little call for instructors and 

students to learn about and apply principles of accessibility.  
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Resources 

 The resources offered by WebAIM cover a diverse field of tools and practices. WebAIM 

maintains guides on advanced HTML accessibility as well as other media such as PDFs and 

Flash files. They offer simulations of assistive technology, and descriptions of the various ways 

people with disabilities interact with computers and the web (WebAIM, 2012b). WebAIM is 

extremely comprehensive; however, the breadth and depth of its resources might be too complex 

for some visitors. A professor who wants to know how to make an accessible table in Microsoft 

Word does not need to know about “Usable and Accessible Form Validation and Error Recovery” 

(WebAIM, 2012b). Additionally, some of the information is not up to date. The section on 

“Word Accessibility” does not cover Microsoft Word 2011, the latest version for the Mac 

Operating System (WebAIM, 2012b).  

 Penn State University publishes “AccessAbility,” a homepage for accessibility and 

usability at the university (Penn State, n.d.). The site lists the most common barriers to 

accessibility and their solutions as well as information on accessibility within common tools such 

as Microsoft Word and PowerPoint. Sections include: News and Events, Disabilities & A.T., 

What to Fix, Common Tools, and Web Developers (Penn State, n.d.). Like WebAIM, 

AccessAbility is fairly comprehensive, listing the most relevant issues and tools. Unlike many 

resources, AccessAbility has been designed for faculty as well as web development staff. 

Organizing information around common issues or tools is helpful for visitors who know exactly 

what they are looking for, but a list of 14 items under “what to fix” would be daunting to a 

professor or student searching for an overview or introduction, especially when those issues are 

not relevant to every task. 
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 In 2010, the National Federation of the Blind (NFB) filed a lawsuit against The 

Pennsylvania State University (Penn State) for failing to provide equal access to blind students 

and faculty on the school’s web sites and cyberinfrastructure. In October of 2011, Penn State and 

the NFB reached an agreement (Penn State, n.d.). As part of the agreement, Penn State extended 

IT accessibility training to faculty and staff, and among other changes, adopted a standard of web 

accessibility, WCAG 2.0. AccessAbility is the result of this agreement: “The University will 

maintain a rich set of web resources which will be located at http://accessibility.psu.edu and will 

provide both tools and training to the webmasters”(Penn State, n.d.). AccessAbility is indeed a 

great resource, but institutions should not wait for a lawsuit to reevaluate their commitment to 

accessibility among all parties.  

Research Question 

 How accessible are the Association of Professional Schools of International Affairs 

member-schools’ web sites? What resources do APSIA schools offer faculty, staff, and students 

related to accessible document creation? 

Methodology 

 The research questions are addressed with a two-part methodology. A sample of 36 

international schools were tested with the WebAIM WAVE, the “web accessibility evaluation 

tool” (WebAIM, 2012a). Given that automated testing tools are suitable for establishing an 

“upper bound” of accessibility (Kelly, et al., 2005, p. 2), the first stage of data collection will 

help determine baseline accessibility across the sample. The second part consists of a case study 

http://accessibility.psu.edu/
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of five schools randomly selected from the original sample. Institution web pages are 

investigated for the presence of accessibility resources.  

 The 36 members of the Association of Professional Schools of International Affairs 

(APSIA) make up the broader sample used in the first stage of data collection. APSIA is an 

organization “dedicated to the improvement of professional education in international affairs and 

the advancement thereby of international understanding, prosperity, peace, and security” (APSIA, 

n.d.). In order to become a member of APSIA, schools must undergo a review in addition to 

meeting four requirements: 

• an educational program of high academic quality; 

• a substantial and demonstrated commitment to the study of international affairs; 

• a basic commitment to graduate professional training; and  

• significant autonomy within a major university, e.g., as one would expect to find with 

a Law School or graduate Business School. (APSIA, n.d.) 

APSIA schools were chosen as a sample in part because of the membership of international and 

high-profile schools, but also because of the influence APSIA may have over the schools as a 

group as a catalyst for policy change. The sample of five schools was randomly selected from the 

APSIA member list, excluding schools without a significant English web presence.  

Automatic Accessibility Evaluation  

 Accessibility evaluation was carried out by inputting the URL of each APSIA school, as 

listed on the APSIA “Member Schools” web page (APSIA, n.d.), into the WebAIM WAVE 

accessibility evaluation tool. In addition to reporting the amount of accessibility errors, WAVE 

overlays each original page with icons and indicators pointing to specific accessibility features, 

errors, and alerts. WAVE distinguishes errors and alerts:  
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• All RED icons indicate accessibility ERRORS. Their presence will almost 

certainly cause accessibility issues.  

• All YELLOW icons indicate ALERTS. They may or may not be accessibility 

issues, but typically indicate an area where accessibility is often an issue or where 

it may be made better. They should each be checked for possible issues. 

(WebAIM, 2012a) 

The number of errors on each page was recorded along with notes on the most common and 

influential errors and alerts that WAVE identified. 

Case Studies 

 Five APSIA institutions were randomly selected for case studies: the Carleton University 

Norman Paterson School of International Affairs, the Georgia Institute of Technology Sam Nunn 

School of International Affairs, Graduate Institute of International and Development Studies, and 

the National University of Singapore Lee Kuan Yew School of Public Policy. In the accessibility 

evaluation stage of data collection, only the link given by APSIA was tested, but the case studies 

were carried out at a deeper level in order to find any accessibility policies and resources. 

 Each school site was browsed for any pages relating to disability such as disability 

support offices or special programs as well as IT department web pages. If no office was found 

by browsing, the school’s internal search engine was used to search for terms such as 

accessibility, accessibility policy, and disability. If the school of international affairs is part of a 

university, the university web site was also searched.  

Findings 

WAVE Tests 
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 Nearly every page tested returned accessibility errors. WAVE found errors an all but two 

school pages, the Syracuse University Maxwell School and Tufts University’s Fletcher School of 

Law and Diplomacy. Further inspection revealed that each school’s site contains accessibility 

errors that WAVE was unable to detect. Table 1: Accessibility Evaluation (Appendix A) 

summarizes the results. Table 2: Case Study School WAVE Evaluations excerpts findings from 

the five case study schools: 

Table 2: Case Study School WAVE Evaluations 

School WAVE Errors Types of Error 

Carleton University Norman Paterson School of 
International Affairs 

8 missing form label 
empty but alt texted link 
nothing major 

Georgia Institute of Technology Sam Nunn School 
of International Affairs 

6 some missing alt text 
missing form labels 
out of order headings 

Graduate Institute of International and 
Development Studies 

6 missing form labels 
some missing alt text 
small text 
headings out of order 

National University of Singapore Lee Kuan Yew 
School of Public Policy 

30 missing form labels 
missing alt text 
layout tables 

University of Texas at Austin Lyndon B. Johnson 
School of Public Affairs   

2 some alt text 
some structure 

Many different errors, minor and major were uncovered, but a few stood out as the most 

common: forms such as search boxes were not coded with a label; images were tagged with 

inappropriate alt text, or no alt text at all; and pages were not structured for optimal usability. 

Pages with more errors often had more content. Each image without alt text returns an error in 

http://www.carleton.ca/npsia
http://www.carleton.ca/npsia
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.carleton.ca%2Fnpsia&js=2
http://www.inta.gatech.edu/
http://www.inta.gatech.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.inta.gatech.edu%2F&js=2
http://graduateinstitute.ch/
http://graduateinstitute.ch/
http://wave.webaim.org/report?url=http%3A%2F%2Fgraduateinstitute.ch%2F&js=2
http://www.spp.nus.edu.sg/
http://www.spp.nus.edu.sg/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.spp.nus.edu.sg%2F&js=2
http://www.utexas.edu/lbj/index.php
http://www.utexas.edu/lbj/index.php
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.utexas.edu%2Flbj%2Findex.php&js=2
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WAVE; more images will result in more errors. Testing with WAVE showed that every school’s 

web page contained readily detectable barriers to accessibility.  

Case Studies 

 Of the five cases investigated, none offered resources on accessible document creation. 

Three schools, Carleton University, Georgia Institute of Technology, and the University of Texas 

at Austin have some sort of disability support office. Only one school, University of Texas at 

Austin displays a web accessibility policy on their website.  

The Paul Menton Centre at Carleton University in Ottawa, Canada is trying to “Help 

Make Carleton Barrier Free” by assisting students and faculty with: 

• The registration process and documentation requirements 

• Services for undergraduate and graduate students with disabilities 

• Accommodation policies and guidelines for faculty and staff 

• Transition programs for prospective students, parents, and educators 

• Volunteer opportunities (Carleton University, 2012) 

When a student submits an accommodation request, the Paul Menton Centre helps faculty 

understand and fulfill their responsibilities. The web site includes “Disability-Specific 

Information” on different types of disabilities, the ways in which disabilities affect academic life 

and work, and accommodations available for specific disabilities (Carleton University, 2012). 

The Paul Menton Centre publishes regular news updates related to campus-wide accessibility. 

The web site does not list or link to resources related to accessible document creation. No 

accessibility policy was found on the Carleton University web site. 

 The Graduate Institute, located in Geneva Switzerland did not have any accessibility or 

disability-related information publicly available on their website. A general search for disability 
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revealed course materials that covered disability-related issues, but there was nothing related 

accessibility or disability at The Graduate Institute itself. Findings from the Lee Kuan Yew 

School of Public Policy at the National University of Singapore are essentially the same. Neither 

the Student Service Centre nor the IT and Networking offices published information on 

accessibility or disability services. 

  Much like the Paul Menton Centre at Carleton University, Georgia Tech’s ADAPTS-

Disability Services Program aims to “improve the educational development of students with 

disabilities and to enhance the understanding and support within the institute through equitable 

access, accommodations, and the provision of programs and services” (Georgia Institute of 

Technology, 2012). ADAPTS also helps instructors understand how to work within the 

accommodations processes at Georgia Tech. The only references to accessible course materials 

is a requirement that in the case of an accommodation request, faculty submit their course 

materials to ADAPTS for the creation of Braille versions or audio tapes (Georgia Institute of 

Technology, 2012). Georgia Tech did not publish an accessibility policy at the time of this case 

study.  

 The web sites of The University of Texas at Austin contain the most disability-related 

resources. The University is home to the Texas Center for Disability Studies. The Center 

conducts research as well as training on disability issues. The materials available on their website, 

however, do not relate to creating accessible documents; they focus on general community 

engagement and inclusion (Texas Center for Disability Studies, n.d.).  

The University of Texas Disability Resources home page offers similar services to 

ADAPTS and the Paul Menton Centre. As at Georgia Tech, the only mention of accessible 

course documents is in reference to Braille or taped versions of materials. They also publish 
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information on different disabilities and “Instructional Tips for Faculty Working with Students 

with Disabilities” (The University of Texas at Austin, 2010).Under the “vision” heading are a 

few very general tips. Faculty, for example, are encouraged to allow low-vision students to sit in 

the front row, but the only guidance offered on course materials is to send documents to the 

Services for Students with Disabilities office.  

The University of Texas at Austin is the only school among the five to publish an 

accessibility policy: “It is the policy of The University of Texas at Austin that all official 

University information published on University Web sites shall be accessible to all users” (The 

University of Texas at Austin, 2012). The University of Texas encourages accessibility paired 

with frequent usability testing, and offers extensive guides on publishing accessible materials 

and conducting usability testing. There are, however, no accessibility guides created specifically 

for faculty and staff who would like to learn about accessible document creation.   

Discussion 

 Accessibility issues uncovered by WAVE evaluation ranged from minor (e.g. a few 

instances of missing or inappropriate alt text) to widespread structural issues that would make 

navigating the web page difficult or impossible for users of screen-readers or other assistive 

technologies. Even the web pages that returned very few or zero errors in WAVE contained 

barriers to accessibility. Many of these issues could be corrected quickly if a developer were 

made aware of the problem. Unfortunately, while developers are responsible for the back-end of 

these websites, non-developers probably populate much of the content. Modern content 

management systems (CMS) such as Drupal make it easy for people without extensive technical 

knowledge to maintain a website. A system can be designed on an accessible framework, but the 



15 
 

intern responsible for creating blog posts might not add alt text to an image or use headings 

correctly.  

 Web developers do not have time to re-check every page on their website every day to 

check for minor accessibility errors. Likewise, an office of disability support cannot check every 

document used in every course at a university. For that reason, accommodation often takes place 

on an as-needed basis. The majority of students and faculty never have to worry about 

accessibility because they believe it does not affect them. Given the general lack of accessibility-

related resources, especially in the area of course content creation, it is no surprise that the 

average student, staff or faculty member is not aware of the need for accessibility. Even when an 

instructor receives a request for accommodations, their involvement often stops at delivering 

materials to Disability Support Services or Services for Students with Disabilities.  

Conclusion 

 Kelly et al. (2007) issued the call for a new vision of accessibility. Web accessibility 

policies are a great first step, but without contextualized resources and training targeted at 

diverse segments of an institutional community, accessibility will never be a common concern of 

faculty, staff, and students as well as web developers and IT staff. More and more classrooms 

today exist in blended environment of physical and virtual space. As electronic content creators, 

students, faculty, and staff all make choices that affect the accessibility of their work. 

Accessibility in many cases only requires authors to follow a few basic best practices that will 

make their works more usable by a wide audience, as well as easier to write.  

A Guide for Faculty, Staff, and Students 
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 The guide, “Creating Accessible Syllabi, Assignments, and Other Text Documents” was 

created to fill this gap. The document speaks directly to instructors who are too busy to sift 

through Penn State’s AccessAbility portal or all of WebAIM’s articles. By organizing techniques 

and principles around common tasks, professors will grasp the scope of each document even if 

they are not familiar with the principles therein. AccessAbility, in contrast, is primarily 

organized around “Top Blockers” and “Common Tools.” An instructor unfamiliar with 

accessibility will not know that “Image ALT Tag Tips” is relevant to creating a text document, 

whereas “Creating Accessible Syllabi” organizes these practices around the most common needs 

of a professor. 

 In the section, “Why Bother,” instructors learn why accessibility matters. “Creating 

Accessible Syllabi” emphasizes the benefits of accessibility as principles that increase the value 

of a work, rather than an annoyance that only affects a small minority. It is very easy to create an 

automatically updated table of contents, for example, with an accessible text document. 

“Creating Accessible Syllabi” is one sample piece of a set of documents that could cover 

different types of course materials such as presentations and course readings. “Creating 

Accessible Syllabi” was designed to reflect “the context of usage, including the aims of a 

service…, [and] the users’ and the services providers’ environments” (Kelly et al., 2007, p. 1).  

Institutional change often occur as a result of top-down policy directives. If faculty, staff, and 

students are made aware of the easy contributions they can make to accessibility, the great 

benefits and small cost, lasting change can come from within. “Creating Accessible Syllabi, 

Assignments, and Other Text Documents” has been designed to initiate that change.   
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Appendix A: Tables 

Table 1: Accessibility Evaluation 

School WAVE Errors Types of Error 

American University School of International 
Service 

5 Some missing alt text. 

Carleton University Norman Paterson School of 
International Affairs 

8 missing form label 
empty but alt texted link 
nothing major 

Columbia University School of International and 
Public Affairs 

8 missing alt text 
missing form labels 

Duke University Sanford School of Public Policy  2 missing form labels 

George Washington Elliott School of International 
Affairs 

2 empty link text 

Georgetown University Edmund A. Walsh School 
of Foreign Service 

2 some missing alt text 
missing form labels 

Georgia Institute of Technology Sam Nunn School 
of International Affairs 

6 some missing alt text 
missing form labels 
out of order headings 

Graduate Institute of International and 
Development Studies 

6 missing form labels 
some missing alt text 
small text 
headings out of order 

Harvard University John F.  Kennedy School of 
Government 

2 button missing alt text 
linked image no alt text 

Johns Hopkins University Paul H. Nitze School of 
Advanced International Studies  

5 missing form labels 
layout tables 

Korea University Graduate School of International 
Studies 

1 missing alt text  

http://www.american.edu/sis
http://www.american.edu/sis
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.american.edu%2Fsis%2F&js=2
http://www.carleton.ca/npsia
http://www.carleton.ca/npsia
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.carleton.ca%2Fnpsia&js=2
http://www.sipa.columbia.edu/
http://www.sipa.columbia.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.sipa.columbia.edu%2F&js=2
http://www.pubpol.duke.edu/graduate/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.pubpol.duke.edu%2Fgraduate%2F&js=2
http://www.gwu.edu/~elliott
http://www.gwu.edu/~elliott
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.gwu.edu%2F~elliott&js=2
http://sfs.georgetown.edu/
http://sfs.georgetown.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fsfs.georgetown.edu%2F&js=2
http://www.inta.gatech.edu/
http://www.inta.gatech.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.inta.gatech.edu%2F&js=2
http://graduateinstitute.ch/
http://graduateinstitute.ch/
http://wave.webaim.org/report?url=http%3A%2F%2Fgraduateinstitute.ch%2F&js=2
http://www.hks.harvard.edu/
http://www.hks.harvard.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.hks.harvard.edu%2F&js=2
http://www.sais-jhu.edu/
http://www.sais-jhu.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.sais-jhu.edu%2F&js=2
http://dis.korea.ac.kr/
http://dis.korea.ac.kr/
http://wave.webaim.org/report?url=http%3A%2F%2Fdis.korea.ac.kr%2F&js=2
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School WAVE Errors Types of Error 

MGIMO University Moscow State Institute of 
International Relations 

18 form labels 
alt text 
layout tables 

National University of Singapore Lee Kuan Yew 
School of Public Policy 

30 missing form labels 
missing alt text 
layout tables 

Princeton University Woodrow Wilson School of 
Public and International Affairs 

8 broken skip navigation 
missing form labels 

Ritsumeikan University Graduate School of 
International Relations 

8 missing alt text 

Sciences Po Paris School of International Affairs  11 missing alt text 

Seoul National University Graduate School of 
International Studies 

* WAVE did not run 

St. Petersburg State University School of 
International Relations  

82 mostly missing alt text 
lots of layout tables 
complicated content 

Stockholm School of Economics 23 form labels 
alt text  

Syracuse University The Maxwell School 0 no headings 

Texas A&M University Bush School of 
Government & Public Service 

1 missing form label 

Tufts University The Fletcher School of Law and 
Diplomacy   

0 no alt text 
empty alt text 
questionable form labels 

UCSD School of International Relations and 
Pacific Studies 

1 form label 

University of Denver Josef Korbel School of 
International Studies   

24 structure alerts 
missing alt text 
missing form label 
event handlers 

http://www.ip.mgimo.ru/
http://www.ip.mgimo.ru/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.ip.mgimo.ru%2F&js=2
http://www.spp.nus.edu.sg/
http://www.spp.nus.edu.sg/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.spp.nus.edu.sg%2F&js=2
http://www.wws.princeton.edu/
http://www.wws.princeton.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.wws.princeton.edu%2F&js=2
http://www.ritsumei.ac.jp/acd/gr/gsir/eng/index.html
http://www.ritsumei.ac.jp/acd/gr/gsir/eng/index.html
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.ritsumei.ac.jp%2Facd%2Fgr%2Fgsir%2Feng%2Findex.html&js=2
http://www.psia.sciences-po.fr/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.psia.sciences-po.fr%2F&js=2
http://gsis.snu.ac.kr/
http://gsis.snu.ac.kr/
http://wave.webaim.org/report?url=http%3A%2F%2Fgsis.snu.ac.kr&js=2
http://www.dip.pu.ru/
http://www.dip.pu.ru/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.dip.pu.ru%2F&js=2
http://www.sse.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.sse.edu%2F&js=2
http://www.maxwell.syr.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.maxwell.syr.edu%2F&js=2
http://bush.tamu.edu/
http://bush.tamu.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fbush.tamu.edu%2F&js=2
http://fletcher.tufts.edu/
http://fletcher.tufts.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Ffletcher.tufts.edu%2F&js=2
http://irps.ucsd.edu/
http://irps.ucsd.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Firps.ucsd.edu%2F&js=2
http://www.du.edu/korbel
http://www.du.edu/korbel
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.du.edu%2Fkorbel&js=2
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School WAVE Errors Types of Error 

University of Maryland School of Public Policy 3 missing form labels 
missing alt text 
structure alerts 

University of Michigan Gerald R. Ford School of 
Public Policy 

8 missing alt text 

University of Minnessota Hubert H. Humphrey 
School of Public Affairs 

7 missing alt text 
 missing and bad 
structure 

University of Pittsburgh Graduate School of Public 
And International Affairs 

8 layout tables 
missing form label  
problematic link text 

University of Queensland The School of Political 
Science & International Studies  

19 missing alt text 
problematic link text 

University of Southern California Master of Public 
Diplomacy 

28 missing form labels 
missing alt text 
structure alerts 

University of St. Gallen Master of Arts in 
International Affairs and Governance 

2 missing form label 

University of Texas at Austin Lyndon B. Johnson 
School of Public Affairs   

2 some alt text 
some structure 

University of Washington Henry M. Jackson 
School of International Studies 

7 structure 
missing form label 
missing alt text 

Yale University The Whitney and Betty MacMillan 
Center   

* WAVE doesn't want to run on it 

Yonsei University Graduate School of 
International Studies 

18 missing alt text 
layout table 
missing form labels 
lots of errors and other alerts 

 

http://www.publicpolicy.umd.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.publicpolicy.umd.edu%2F&js=2
http://www.fordschool.umich.edu/
http://www.fordschool.umich.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.fordschool.umich.edu%2F&js=2
http://www.hhh.umn.edu/
http://www.hhh.umn.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.hhh.umn.edu%2F&js=2
http://www.gspia.pitt.edu/
http://www.gspia.pitt.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.gspia.pitt.edu%2F&js=2
http://wave.webaim.org/report?url=http%3A%2F%2Fpolsis.uq.edu.au%2F&js=2
http://www.annenberg.usc.edu/
http://www.annenberg.usc.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.annenberg.usc.edu%2F&js=2
http://www.mia.unisg.ch/
http://www.mia.unisg.ch/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.mia.unisg.ch%2F&js=2
http://www.utexas.edu/lbj/index.php
http://www.utexas.edu/lbj/index.php
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.utexas.edu%2Flbj%2Findex.php&js=2
http://jsis.washington.edu/
http://jsis.washington.edu/
http://wave.webaim.org/report?url=http%3A%2F%2Fjsis.washington.edu%2F&js=2
http://www.yale.edu/macmillan/
http://www.yale.edu/macmillan/
http://wave.webaim.org/report?url=http%3A%2F%2Fwww.yale.edu%2Fmacmillan%2F&js=2
http://gsis.yonsei.ac.kr/
http://gsis.yonsei.ac.kr/
http://wave.webaim.org/report?url=http%3A%2F%2Fgsis.yonsei.ac.kr%2F&js=2
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Creating Accessible 
Syllabi, Assignments, and 
other Text Documents 
Create accessible syllabi and assignments using a word processor such as Microsoft Word by 
following a few basic guidelines: 

● use headings to define document structure 
● add alt-text to any images  
● use properly formatted tables to display data 
● add hyperlinks to a document 

With these techniques in mind, you will be able to create more accessible documents that are 
more usable for your students, and easier for you to edit and format during the writing process. 
This document walks you through the basics of text document accessibility. 
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Adding Headings in Microsoft Word ............................................................................................................. 8 
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Why Bother? 
Accessible documents are not only useful for students with disabilities, but may help you and 
your students browse and navigate your files. If your syllabus includes headings, for example, a 
student can jump directly to any section within the document, without having to scroll the entire 
file. Headings also make it easy to automatically populate a table of contents with links to each 
page. As e-readers become more popular and ubiquitous, accessible text files can be turned 
into an HTML file or PDF that can be browsed on a mobile device.  

These techniques help remove barriers that might prohibit students from reading or interacting 
with your documents. Following these best practices will make your documents easier to use 
and easier to create. Taking responsibility for your own materials will lead to more valuable end 
products that can reach a wider audience. 

Document Scope 
This document will help you create accessible text documents, and familiarize you with many 
general principles of accessibility. It is not, however, all-encompassing. Accessibility is part of a 
process. This guide addresses some of the factors that relate to content creation. If you would 
like to better understand the big-picture view of accessibility, look into Universal Design for 
Learning: 

[UDL] is a set of principles for curriculum development that give all individuals equal 
opportunities to learn. UDL provides a blueprint for creating instructional goals, methods, 
materials, and assessments that work for everyone--not a single, one-size-fits-all 
solution but rather flexible approaches that can be customized and adjusted for 
individual needs. 

http://www.cast.org/udl/
http://www.cast.org/udl/
http://www.cast.org/udl/
http://www.cast.org/udl/
http://www.cast.org/udl/
http://www.cast.org/udl/
http://www.cast.org/udl/
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Creating accessible documents is a first step in teaching with UDL principles. Your university or 
college most likely has an office in charge of disability support. If you have any questions, your 
institution probably has many resources to help you reach all of your students effectively.  

A Note about Software 
This document will cover the basic techniques of creating accessible documents with specific 
examples from the Microsoft Office suite. Because technology evolves so quickly, the 
recommendations outlined in this document are relevant and applicable across multiple 
platforms. Examples will be given for Microsoft Office, but the recommendations will still be 
applicable for users of others suites such as OpenOffice and Google Docs. This document 
follows all of its own recommendations. Feel free to explore this file, taking a look at the 
headings, alt text and other features. 

While writing a text document, your decisions will have the greatest impact on blind and low-
vision users as well as those with mobility impairments who interact with their computers using 
speech-recognition software. A screen reader is a form of assistive technology that reads 
content aloud to users. The WebAIM Screen Reader Simulation is a great way to begin to 
understand how some people use computers.  

Creating Accessible Text Documents 

Headings 
Section headings make it easy for a reader to understand the structure of a document. 
Headings and subheadings in this document, for example, allow readers to more easily find a 
particular section of the guide. In order for all users to benefit from your headers, it is important 
that they are tagged properly.  

Some students and instructors will have trouble with large amounts of unstructured or manually 
formatted text. A screen reader reads untagged text from top to bottom, and it can be very 
difficult to skim a document or find a specific section without listening to the whole text. Speech 
recognition software can interact with structured headings more easily than scrolling through a 
long document.  

If you are viewing this document in Microsoft Word, you can experience the benefits of tagged 
headings by opening the Navigation Pane. Click View > Navigation Pane (Word 2010)  or 
View > Sidebar > Document Map Pane (Word 2011). From this menu, you can expand or 
collapse sections of a document. In addition, the table of contents above was automatically 
generated based on this document’s headings. If I change a heading, or add more text, I can 
automatically update the table of contents to the new content.  

Properly Tagged Headings: 

http://webaim.org/simulations/screenreader/
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● Are navigable by users of screen readers and speech recognition adaptive technologies. 
○ Readers can call up a list of headings and jump to specific sections, rather than 

sifting through the whole document word by word.  
● Automatically apply formatting to the text. You do not need to manually change the size 

and font of text each time. 
● Allow you to more easily export a document to another format such as HTML or an e-

book format while retaining document structure.  

Most word processors today come with sets of built in “styles.” These allow you to define text as 
“Heading 1,” “Normal” text, or other types such as block quotes. Different styles will 
automatically be formatted differently. Many users add headers manually by increasing the size 
and bolding the text. Sighted users can see the effects of manual formatting, but a screen 
reader cannot distinguish formatting unless it is tagged as described. Using styles will format the 
text automatically, and add built-in structure to your document that is perceptible to assistive 
technology.  

More information: Adding Headings in Microsoft Word  

Alt Text 
Tagging alt text will help your students and colleagues who have visual impairments understand 
the content of images. A screen reader will be able to read aloud your description, conveying 
the purpose and content of every image. You can embed a description of the image into the 
picture itself so that all your students benefit from embedded graphics.  

Writing Alt Text  

Alt text should convey the content and function of an image. Here are some guidelines from the 
WebAIM article Appropriate Use of Alt Text. Alt text should: 

● “Be accurate and equivalent” to the image described. 
● “Be succinct.”  
● “NOT be redundant.” Alt text should not repeat information found in the original context 

of the image. 
● “NOT use the phrases ‘image of …’ or ‘graphic of …’ to describe the image.” 

If you have any questions about alt texting correctly, you’ll find Appropriate Use of Alt Text very 
helpful.  

More Information: Adding Alt Text in Microsoft Word 

Tables 
Tables are a useful way to organize information in a document, but if used incorrectly, they can 
seriously impact usability and accessibility.  

http://webaim.org/techniques/alttext/
http://www.google.com/url?q=http%3A%2F%2Fwebaim.org%2Ftechniques%2Falttext%2F&sa=D&sntz=1&usg=AFQjCNG0MH_DF0brxcVYiAjo0urtK3KzaA
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Accessible Tables 

● are used to organize data 
● are not used for document layout 
● include text descriptions when used to organize complex data 
● include tagged headers 

Tables are sometimes used to organize a document’s content into a particular layout. If 
important information is included in a table that itself is embedded into a text file, that 
information is much harder to navigate with a screen-reader. It is harder to use and navigate 
with headings in a table. As such, tables should only be used to present data. Headings are 
more appropriate for defining whole-document layout and organization than tables.  

The simpler the table, the more accessible it will be. Each table should have only one heading 
row. If you want to change headings in the middle of a table, it would be better to create a 
separate table altogether. Every row should have the same number of columns; avoid merging 
cells across a row or column.  

Many instructors like to use tables to organize their syllabi. While they can be a useful way for 
your students to visualize assignments and due dates, often this leads to overly complex tables 
with too much information packed into each cell. Rather than trying to fit an entire semester into 
one table, break out units and classes into headings and subheadings. These sections can be 
descriptive and detailed. You could supplement these descriptions with a simple table 
summarizing course dates. The following table is excerpted from an actual syllabus, TESL-502 
Spring 2012, English Language Teaching-II by Dr. Younghee Sheen. Full reading citations and 
assignment descriptions are included in the body of the syllabus.  

Sample Course Outline Table: 

Date Topic Readings (to be completed 
before this class date)  

Assignments (due on 
this class date by 
midnight) 

1/18 

 

ELT-I Review and ELT-
II overview 

Harmer: Ch.1, Ch.3 & Ch.4 
(after class readings) 

Brief language learning 
and teaching bio (on 
Blackboard) 

1/25 Lesson planning 
Brown: Ch.10 
Harmer: Ch.21 
DVD: Silvana & Tony 
# 1 Wyatt (2011) 

Article presentation # 1 

 

2/1 Teaching listening  
Brown: Ch.18 
Harmer: Ch.18  
DVD: Allan & Elli 
# 2 McBride (2011) 

 Article presentation # 2  
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More information: Adding Header Rows to Tables in Microsoft Word 

Hyperlinks 
One benefit of digital files is the ability to connect directly with external resources through 
hyperlinks. Links are easy to add to a document, as most word-processors will automatically 
convert URLs (http://www.....) into a “live” hyperlink so that when a reader clicks on it, the 
website will open in their browser.  

Accessible Hyperlinks: 

● are tagged as hyperlinks, not just a raw URL 
● context-independent 
● are both a different color and underlined 

Embedded Hyperlinks 

Unfortunately, a plain-text URL does not make much sense when read by a screen-reader. 
Instead of adding a link like this: 

See WebAIM for more information on web accessibility: 

http://www.webaim.org 

Try embedding a link directly into your text: 

See WebAIM for more information on web accessibility. 

In most cases, adding a hyperlink is as simple as highlighting text, right clicking, and selecting 
“hyperlink...” or a similar option.   

Choosing Hyperlink Text 

In addition to embedding hyperlinks into text, it is also important to choose the right text for the 
link. Assistive technology such as screen-readers allows your students to browse through all of 
the links in a document as a list. For this reason, links should be able to stand alone. A reader 
should know where the link points based only on the link text itself. For example: 

See WebAIM for more information on web accessibility. 

In this example, the link text just says, “more information.” In a long document full of such links, 
“more information” is not enough information! This link should be tagged like this: 

See WebAIM for more information on web accessibility. 

Your student will know exactly where the link takes her even if she reads it out of context.  

Converting to Other Formats 

http://www.webaim.org/
http://www.webaim.org/
http://www.webaim.org/
http://www.webaim.org/
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Converting to Accessible PDFs 

PDFs are a great way to distribute a paper or other document, but of course they come with 
their own accessibility challenges. Fortunately, it’s easy to create an accessible PDF from an 
accessible text document.  

Creating PDFs with Adobe Acrobat X Pro 

Acrobat X Pro is the easiest tool for creating good quality PDFs from Microsoft Word 2010 or 
2011. Acrobat X Pro is a commercial product different from Adobe Reader, a free tool for 
reading, but not editing or creating PDFs. If you happen to have access to Acrobat, simply: 

1. Click on File > Save as Adobe PDF or click Create Adobe PDF from the Acrobat 
ribbon.  

2. Click on options and make sure that Enable Accessibility and Reflow with tagged 
Adobe PDF is checked.  

3. Click OK and save your document.  

Creating PDFs with Microsoft Word 2010 (Windows) 

The latest version of Microsoft Word for Windows comes with solid built-in PDF conversion.  

1. Click File > Save as 
2. Select PDF under the Save as type: dialogue. 
3. Click options. 
4. Make sure that Document structure tags for accessibility is checked. 
5. Click OK and save your document. 

Creating PDFs with Microsoft Word 2007 (Windows) 

Word 2007 cannot export PDFs without the free Microsoft Save as PDF or XPS plugin. 

1. Install the Microsoft Save as PDF plugin. 
2. Click File > Save as. 
3. Select PDF under the Save as type dialogue. 
4. Click Options. 
5. Make sure that Document structure tags for accessibility is checked. 
6. Click OK and save your document. 

Creating PDFs on a Mac 

Unfortunately, no version of Microsoft Office for Mac has the ability to save accessible PDFs. If 
you do not have access to Acrobat X Pro or a Windows copy of Microsoft Office, it is still 
possible to turn a well-formatted and tagged Word document into an accessible PDF using the 
free OpenOffice suite. 

1. Install OpenOffice. 
2. Open your .doc file in OpenOffice. 

http://www.microsoft.com/en-us/download/details.aspx?id=7
http://www.google.com/url?q=http%3A%2F%2Fwww.microsoft.com%2Fen-us%2Fdownload%2Fdetails.aspx%3Fid%3D7&sa=D&sntz=1&usg=AFQjCNEIQQ_EoKiz6WTX6-RpT-O_X4FQXw
http://openoffice.org/
http://openoffice.org/
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3. Click File > Save as. 
4. Select Tagged PDF.  
5. Click OK and save your document.  

Creating Accessible HTML from Word Documents 

An accessible Word document is very easy to export into well-structured HTML. HTML files are 
particularly accessible because users do not require any special software such as Adobe 
Reader or Microsoft Office and they can be put on the Internet with little extra work or 
formatting. Many online journals offer articles in both PDF and HTML formats for this reason.  

1. Click File > Save as. 
2. Select Web Page, Filtered. 
3. Click OK and save your document.  

Appendix A: Accessibility in Microsoft Word 

The Microsoft Word 2010 Accessibility Checker 
Microsoft Word 2010 comes with a built-in accessibility checker. This tool lets you know if you 
missed anything such as alt text in your document and includes a quick summary of how to fix 
the problem. Automated tools such as this one are a great supplement to your own efforts. The 
Accessibility Checker will tell you if an image is missing alt text, but it will not tell you if your alt 
text is appropriate.  

1. Click File > Check for Issues > Check Accessibility. 
2. The report will open in a sidebar. Click on a specific issue to get more information.   

Adding Headings in Microsoft Word  
The keyboard shortcut ctrl + alt + 1, 2, or 3 on Windows or command + option + 
1, 2, or 3 on a Mac will turn highlighted text into a Heading 1, 2, or 3, respectively. The next 
sections explain how to add headings using specific versions of Microsoft Word. 

Microsoft Word 2007 and 2010 (Windows) 

In Word 2010, you can choose headings from the “Home” toolbar under the “Styles” pane. 
Simply select text and click on one of the available headings. You may also select a heading 
style and then type your text.  
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Microsoft Word 2011 (Mac) 

Word 2011 for Mac works just like Word 2010 for Windows (see above). Select a heading from 
the Styles pane to tag highlighted text or before typing the heading.  

 

Word 2011 allows you to turn on “Styles Guides” that help you visualize content hierarchies in 
your file. It also gives you the option to highlight manually formatted text, which should be 
avoided in favor of styles. This is useful if you are trying to add headings to a document after it 
was already formatted manually. Text formatted as Heading 1 might look the same as text 
manually changed to 14pt bold font, but the Style Guide will make it easier to apply consistent 
styles to an old document.  
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Microsoft Word 2008 (Mac) 

Styles can be accessed in Word 2008 for Mac through the “formatting palette.” Open the palette 
by selecting View > Formatting Palette. From here, you can select a style from the drop-down 
list.  

Adding Alt Text in Microsoft Word 

Microsoft Word 2010 (Windows) 

1. Right-click the image you would like to tag. 
2. Select Format Picture. 
3. In the sidebar, select Alt Text. 
4. Add your alt text to the Description field. Leave the Title field blank. 

a. Note: if you are opening a .doc file created in an earlier version of Microsoft 
Word, it will open in “compatibility mode.” If this is the case, you may only be 
given one field in which to enter alt text.  
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Microsoft Word 2011 (Mac) 

1. Right-click the image you would like to tag. 
2. Select Format Picture. 
3. In the sidebar, select Alt Text. 
4. Add your alt text to the Description field. Leave the Title field blank.  

 

Microsoft Word 2007 (Windows) 
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1. Right-click the image you would like to tag. 
2. Select Size. 
3. Select the Alt Text tab. 
4. Add your alt text. 

Older Versions of Microsoft Office for Mac 

Unfortunately, Word 2011 for Mac is the only version of Microsoft Word that supports adding alt 
text. You can always use in-text captions of images to ensure accessibility, but if you would like 
to tag your images with alt-text, you will have to use an alternate office suite. OpenOffice is a 
popular, free, and powerful office suite that does allow for alt-text in addition to all of the other 
features described in this document. 

Adding Header Rows to Tables in Microsoft Word 

Microsoft Word 2010 (Windows) and 2011 (Mac) 

1. While editing a table, click on the Design (Windows) or Table (Mac) tab. 
2. Check the Header Row box. 
3. If you are using a header column, also check First Column. 
4. If your table spans multiple pages, it can be helpful to have headings repeat on a new 

page by right clicking on the first row and selecting Table Properties. 
5. Check the box labeled Repeat as header at the top of each page.  

http://www.openoffice.org/
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